Overview

Movavi Screen Capture is an easy-to-use application for recording screencasts. You can use it to record video tutorials, online video streams, game walkthroughs and anything else on your computer screen, including screenshots.

Not sure where to begin? Read the Quick Start Guide and begin making screencasts in just a few minutes!
Supported Formats

Please see our full list of supported formats and devices here.
System Requirements

Minimum System Requirements:

- Microsoft Windows 2000/XP/Vista/7/8 with up-to-date patches/service packs installed
- Intel or AMD or compatible processors, 1GHz
- Minimum graphics display resolution of 1024x768, 32-bit color
- 256MB RAM for Windows 2000 and XP, 512MB for Vista, 1GB for Windows 7 and Windows 8
- Minimum 50MB free hard disk space for installation, 1GB for ongoing operations
- Latest version of QuickTime Player for Windows for MOV file processing
- Administrator permissions are required for installation

Note: Movavi Screen Capture may run on slower computers; however, stable performance of the application in such cases is not guaranteed.
Hardware Acceleration
Movavi Screen Capture supports Intel® Media and NVIDIA CUDA™ hardware acceleration methods. If your computer is equipped with compatible hardware, you can convert your recordings much faster, and your computer will run smoother during capture.

NVIDIA™ GPU Acceleration
If your computer is equipped with an NVIDIA™ graphics card, you can use it to accelerate media file processing up to 5x by shifting a part of the workload to the graphics processing unit, freeing up your computer’s CPU for other tasks. This technology supports the newest NVIDIA™ graphics cards, including GeForce, GeForce Mobile, Quadro, and Quadro Mobile. You can find the full list of supported GPUs on our webpage.

Supported Formats:
Input Video Formats: AVI, MP4, FLV, MKV, MOV, MPEG2-TS with H.264 codec, MPEG (MPEG2 PS, MPEG2 TS) with MPEG1/MPEG2 codec, WMV with VC-1 codec.
Output Video Formats: 3GP, 3GP2, AVI, FLV, M2TS, MKV, MP4 with H.264 codec.

Intel® Media Acceleration
Movavi Screen Capture also supports hardware acceleration provided by Intel® multi-core processors, which allows for faster encoding/decoding, as well as simultaneous conversion of a large number of files by employing the full power of each core. Performance grows up to 400% for H.264 and MPEG-2 codecs and up to 8 files can be processed simultaneously.

Supported Formats
Input Video Formats: AVI, MP4, FLV, MKV, MOV, MPEG2-TS with H.264 codec; MPEG (MPEG2 PS, MPEG2 TS) with MPEG1/MPEG2 codec; WMV with VC-1 codec.
Output Video Formats: 3GP, 3GP2, AVI, FLV, M2TS, MKV, MP4 with H.264 codec; M2TS, MPEG with MPEG2 codec.

To enable Intel® or NVIDIA™ acceleration in <TODO>: insert variable value here:
1. Open the Capture menu and select Options.
2. In the Acceleration section, select the acceleration method that you prefer. For Intel® acceleration, you can choose hardware or software acceleration methods for each of the supported codecs.

If your processor or graphics card model is listed as supported, yet the acceleration options are still unavailable, please update the device's driver.
Copyright and License

IMPORTANT: THIS SOFTWARE END USER LICENSE AGREEMENT ("EULA") IS A LEGAL AGREEMENT BETWEEN YOU AND AFFIANCE GROUP LIMITED ("MOVAVI.COM"). USE OF THE SOFTWARE PROVIDED WITH THIS EULA (THE "SOFTWARE") CONSTITUTES YOUR ACCEPTANCE OF THESE TERMS. READ IT CAREFULLY BEFORE COMPLETING THE INSTALLATION PROCESS AND USING THE SOFTWARE. IF YOU DO NOT AGREE TO THE TERMS OF THIS EULA, DO NOT INSTALL AND/OR USE THIS SOFTWARE. BY INSTALLING, COPYING, OR OTHERWISE USING THE SOFTWARE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS OF THIS EULA.

1. LICENSE GRANT. The Software is licensed on per computer basis, not per user, site or company. For example, if a person uses 2 computers, to install and use the Software on every computer, the person must purchase 2 licenses. "User" means the company, entity or individual whose funds are used to pay the license fee. "Use" means storing, loading, installing, executing or displaying the Software. You may not modify the Software or disable any licensing or control features of the Software except as an intended part of the Software programming features. This license is not transferable to any other system, or to another organization or individual.

2. TRIAL and REGISTRATION. You are granted the right to use the Software without registration solely for the purposes of evaluating the performance of the Software for a period of no more than seven (7) days. In addition, watermark is laid upon the processed video when using a trial copy of the Software. To remove the restrictions of the trial copy, you have to register it with Movavi.com in accordance to the terms laid out in the registration information which can be found in the documentation accompanying the Software. You are expected to use the Software on your system and to thoroughly evaluate its usefulness and functionality before making a purchase. This "try before you buy" approach is the ultimate guarantee that the Software will perform to your satisfaction.

3. OWNERSHIP. The Software is owned and copyrighted by Movavi.com. Your license confers no title or ownership in the Software and should not be construed as a sale of any right in the Software.

4. COPYRIGHT. The Software and all rights, without limitation including proprietary rights therein, are owned by Movavi.com or its suppliers and are protected by copyright laws and international copyright treaties, as well as other intellectual property laws and treaties. The Software is licensed, not sold. You acknowledge that no title to the intellectual property in the Software is transferred to you. You further acknowledge that title and full ownership rights to the Software will remain the exclusive property of Movavi.com and you will not acquire any rights to the Software except as expressly set forth in this license. You agree that any copies of the Software will contain the same proprietary notices which appear on and in the Software.

5. REVERSE ENGINEERING. You agree that you will not attempt to reverse compile, modify, translate, or disassemble the Software in whole or in part.

6. NO OTHER WARRANTIES. THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND. MOVAVI.COM DISCLAIMS ALL OTHER WARRANTIES WITH RESPECT TO THE SOFTWARE, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY MAY LAST, OR THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION TO JURISDICTION. The Software automatically references, displays, links to and provides web services related to sites and information located worldwide throughout the Internet. Because Movavi.com has no control over such sites and information, Movavi.com makes no guarantees as to such sites and information, including but not limited to: (a) the accuracy, availability, sequence completeness, currency, content, validity or quality of any such sites and information, or (b) whether they may locate unintended or objectionable content. By using the Software, you acknowledge that Movavi.com makes no representations or warranties with regard to any sites or information displayed by or accessed though the Software.

7. THIRD PARTY ACKNOWLEDGMENTS. Portions of the Software may utilize or include third party software and other copyrighted material. The use of such material is governed by their respective terms. Certain software libraries and other third party software included with the Software are free software and licensed under the terms of the GNU Library Lesser General Public License (LGPL). You may obtain a complete machine-readable copy of the source code for such free software under the terms of the LGPL without charge except for the cost of media, shipping and handling, upon written request to Movavi.com. The LGPL software is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY, without even the implied warranty of MERCHANTABILITY or FITNESS OF PURPOSE.
MPEG-2 Notice. To the extent that the Software contains MPEG-2 functionality, the following provision applies: ANY USE OF THE PRODUCT OTHER THAN CONSUMER PERSONAL USE IN ANY MANNER THAT COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM MPEG LA, L.L.C., 250 STEELE STREET, SUITE 300, DENVER, COLORADO 80206.

Use of MPEG-4 To the extent that the Software contains MPEG-4 functionality, the following provision applies: THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD ("MPEG-4 VIDEO") AND/OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NONCOMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED BY MPEG LA TO PROVIDE MPEG-4 VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM.

H.264/AVC Notice. To the extent that the Software contains AVC encoding and/or decoding functionality, commercial use of H.264/AVC requires additional licensing and the following provision applies: THE AVC FUNCTIONALITY IN THIS PRODUCT IS LICENSED HEREIN ONLY FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER TO: (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD ("AVC VIDEO") AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR AVC VIDEO THAT WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. INFORMATION REGARDING OTHER USES AND LICENSES MAY BE OBTAINED FROM MPEG LA L.L.C. SEE HTTP://WWW.MPEGLA.COM.

AMR Notice. To the extent that the Software contains AMR encoding and decoding functionality, the following provision applies: The Adaptive Multi-Rate ("AMR") encoding and decoding functionality in this product is not licensed to perform cellular voice calls, or for use in any telephony products built on the QuickTime architecture for the Windows platform. The AMR encoding and decoding functionality in this product is also not licensed for use in a cellular communications infrastructure including: vase stations, base station controllers/radio network controllers, switching centers, and gateways to and from the public switched network.

MPEG Layer-3 Notice. To the extent that the Software contains MPEG Layer-3 encoding and decoding functionality, the following provision applies: Supply of this product does not convey a license nor imply any right to distribute MPEG Layer-3 compliant content created with this product in revenue-generating broadcast systems (terrestrial, satellite, cable and/or other distribution channels), streaming applications (via Internet, intranets and/or other networks), other content distribution systems (pay-audio or audio-on-demand applications and the like) or on physical media (compact discs, digital versatile discs, semiconductor chips, hard drives, memory cards and the like). An independent license for such use is required. For details, please visit http://mp3licensing.com.

VP6DecLib. To the extent that the Software utilizes VP6DecLib, the following provision applies: VP6DecLib is derived from FFmpeg sources. FFmpeg is a trademark of Fabrice Bellard (originator of the FFmpeg project - FFmpeg project, http://ffmpeg.mplayerhq.hu) VP6DecLib is licensed under the Lesser GNU Lesser General Public License. GNU Lesser General Public, Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA and you can distribute it and/or modify it under the terms of such license.

8. YOUR INFORMATION and MOVAVI.COM’S PRIVACY POLICY

8.1 Privacy Policy. The personal information you provide to Movavi.com during the ordering and registration process is used for Movavi.com's internal purposes only. Movavi.com uses the information it collects to learn what you like and to improve the Software. Except as otherwise expressly permitted by this EULA or as otherwise authorized by you, Movavi.com will not give any of your personal information to any third party without your express approval except as reasonably required by law, as authorized by this provision or as necessary to protect Movavi.com, its agents and other Participants. Movavi.com can (and you authorize Movavi.com to) disclose any information about you to private entities, law enforcement agencies, or government officials, as Movavi.com, in its sole discretion, believe necessary or appropriate to investigate or resolve possible problems or inquiries, or as otherwise required by law.

8.2 Standard Marketing. Movavi.com reserves the right to identify you to the public as a customer of Movavi.com and use your name and credentials in an appropriate and acceptable manner for standard marketing promotions. Acceptable and standard marketing promotions include but are not limited to: Client listings, case studies, press releases, surveys, interviews, reputable business publications, television and web site presentation and promotion etc. Nothing contained in this Section 8.2 shall be construed as an obligation by you to disclose any of your proprietary or confidential information to any third party. In addition, you may opt-out from this Section 8.2 by writing an opt-out request to Movavi.com at support@movavi.com

8.3 Email Communication. You agree that Movavi.com may communicate with you via email and any similar technology for any purpose relating to the Software, other Movavi.com products and any services or software which may in the future be provided by Movavi.com or on Movavi.com's behalf. If you do not want to receive communication from Movavi.com, you can
unsubscribe at any time following the instructions contained in any email received from Movavi.com or by writing an opt-out request to Movavi.com at support@movavi.com.

9. SEVERABILITY. In the event of invalidity of any provision of this license, the parties agree that such invalidity shall not affect the validity of the remaining portions of this license.

10. NO LIABILITY FOR CONSEQUENTIAL DAMAGES. IN NO EVENT SHALL MOVAVI.COM OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, SPECIAL, INCIDENTAL OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF THE DELIVERY, PERFORMANCE OR USE OF THE SOFTWARE, EVEN IF MOVAVI.COM HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL MOVAVI.COM's LIABILITY FOR ANY CLAIM, WHETHER IN CONTRACT, TORT OR ANY OTHER THEORY OF LIABILITY, EXCEED THE LICENSE FEE PAID BY YOU, IF ANY.

11. GENERAL PROVISION. This is the entire agreement between you and Movavi.com, which supersedes any prior agreement or understanding, whether written, or oral, relating to the subject matter of this EULA. If any part of this EULA is found void and unenforceable, it will not affect the validity of the balance of the agreement, which shall remain valid and enforceable according to its terms. This EULA shall automatically terminate upon failure by you to comply with its terms. Movavi.com, on its sole discretion, may modify this EULA in writing at any time.
Activating Software

When you first install a copy of Movavi Screen Capture, it will be running in Trial Mode, which restricts capture length and applies a watermark to converted videos. To be able to use the program to its fullest, you will need to activate it using an activation key that you can purchase from our official website or any of our partners.

Please see the following sections on some of the frequently asked questions about activation:

- How do I get an activation key?
- What are the trial limitations?
- How do I activate the program? I have a stable Internet connection.
- Can I activate the program if I don't have Internet access?

If you have any other questions or you find that activation is not working correctly, please don't hesitate to contact our support team.
Trial Limitations

Unactivated copies of Movavi Screen Capture are subject to the following trial limitations and will only function for 7 days after being installed.

- Maximum capture time for each video is two minutes.
- A watermark with the Movavi logo is applied to converted videos.

To remove these limitations, buy a license and activate Movavi Screen Capture using the key you receive after purchase. Please see the Activating Software section for more information on activating Movavi Screen Capture.

[!] Videos, captured in the trial version can be converted without the watermark once the program has been activated, as long as you keep the temporary *.mrec recording file. See the Saving Previously Captured Files section on how to open recordings.
Getting an Activation Key

1. To purchase an activation key, open the Help menu in Movavi Screen Capture and select **Buy Now**, or just use the button below:

![Buy Now Button]

2. Choose a personal or **business** license and click the corresponding **Buy Now** button. If you intend to use Movavi Screen Capture commercially, that is, to obtain profit of any kind or in a government organization, you need to select a **business license**.

3. Fill in your billing information and enter a valid e-mail address. This e-mail will be used to deliver your activation key, so make sure you have entered it correctly and that you have access to it.

4. After you've completed your payment and your request has been processed, you will receive a confirmation e-mail with your **activation key**, which you can use to activate **Movavi Screen Capture**.

**If you haven't received your activation key:**

- Check the Spam folder of your mailbox
- [Contact support](#)
This section explains how to activate Movavi Screen Capture using the quick online activation method if your computer is connected to the Internet. If your computer does not have a stable Internet connection, or you are having trouble with online activation, please see the Offline Activation section.

**Step 1: Open the Activation Wizard**

1.1. Launch Movavi Screen Capture.
1.2. In the Help menu, select Activate Software. The Activation Wizard will open.
1.3. Click Next to continue to the next step.

**Step 2: Enter Your Activation Key**

2.1. Enter or paste your activation key into the box of the Activation Wizard.
2.2. Select Internet Activation.
2.3. Click Next to verify your activation key.
You should see a successful activation message. Click **Finish** to close the Activation Wizard and restart the program.

**If online activation fails, try the following:**

- Check that the activation key is entered correctly and is intended for the program you are activating.
- Make sure you have administrator rights on your computer.
- Try disabling your computer's firewall and antivirus software.
- Try **Manual (Offline) Activation**.

If you have any questions or problems while activating your Movavi software, please don't hesitate to [contact our technical support team](mailto:help@movavi.com).
Offline Activation

This topic explains how to activate Movavi Screen Capture if you do not have a stable Internet connection or if the online activation method did not work.

Step 1: Open the Activation Wizard
1.1. Launch Movavi Screen Capture.
1.2. In the Help menu, select Activate Software. The Activation Wizard will open.
1.3. Click Next to continue to the next step.

Step 2: Enter Your Activation Key
2.1. Enter or paste your activation key into the box of the Activation Wizard.
2.2. Select Offline Activation.
2.3. Click Next to proceed to the next step.
Step 3: Send an E-mail with Your Activation Key
The next page of the Activation Wizard contains the activation key you entered and some other information that is necessary for successful activation. To complete this step, you will need to send this information to our activation server via e-mail. You will receive an automatic response containing a registration key, which you will need to enter into the Activation Wizard's window.

3.1. First, you will need to copy or save the information for later, when you send us the e-mail. Click Copy to copy the information to clipboard or click Save to save it as a text file.
3.2. When you have Internet access, use your preferred mail client to compose an e-mail. Fill out the fields as follows:
To: reg@movavi.com
Subject: Activation of Movavi Screen Capture
In the Body field, paste the information you copied from the Activation Wizard. Then, send the e-mail to reg@movavi.com. You should receive a reply within an hour.

To ensure a quick reply from our activation server, please do not alter the message subject or body.

Step 4: Enter Your Registration Key
4.1. When you have received your registration key, return to the Activation Wizard and enter it into the corresponding box.
4.2. Enter your registration name into the corresponding box.
4.3. Click Next to submit the information.

If you have entered all the information correctly, you should see a successful activation message. Click Finish to complete the activation process and restart the program.
If you are having trouble activating Movavi Screen Capture, feel free to contact our support team.
User Interface
When you launch Movavi Screen Capture, you will see it appear on your desktop as a small options window and a larger transparent rectangle, like so:

The transparent rectangle represents the capture area, namely, the area of your screen that you would like to be shown in your video. Its position and size properties are displayed at the top of the rectangle. The window beneath the capture area is your capture control panel which you can use to set up and control the capturing process. This control panel will change depending on the stage of recording you are on, and has three states: before recording, during recording, and after recording.

Click on each panel to find out about its functions:

I. Before Capture

II. During Capture

III. After Capture
Before Capture

Menu
The Menu contains many useful commands and options, such as taking a screenshot or setting various mouse effects.

Custom capture area selection
The Select button enables a smart capture area selection mode, where you can specify the capture area by either selecting an automatically recognized window or frame, or clicking and dragging to draw the capture area on the screen.

Size selection
The size selection box contains a list of common capture sizes which you can choose from, including capturing the entire monitor.

Custom capture area properties
If you need to capture a custom area of definite size, you can enter its width and height into the corresponding fields.

Audio channel selection
Select the preferred audio channel from the drop-down list. If you want to record your video without sounds, simply uncheck the Audio option.

Audio channel volume
Drag the slider to set the recording volume. You will be able to change the volume during capture.

Record button
When you are done with the set-up, click the REC button to begin recording.

Capture mode
Depending on what you want to capture, select the most suitable capture mode: Screencast, Online Video, or Game. To learn more about the difference between these, see the Choose Capture Mode section.

For detailed instructions on setting up the program before capturing, please see the Preparing to Capture section.
During Capture

1. **Capture duration**
   Here you can see the total duration of the video.

2. **Capture volume**
   Use the slider to change the audio volume.

3. **Cancel capture**
   The **Cancel** button terminates capturing without saving the video.

4. **Pause capture**
   The **Pause** button pauses capturing so that you can resume capturing the video from where you left off.

5. **Stop capture**
   The **Stop** button stops the capturing process and you can proceed to saving the video.
After Capturing

1. **Player**
   Use the player to preview your video before saving.

2. **Delete recording**
   The Delete button permanently deletes the video along with any temporary capture files.

3. **Select format**
   Select which format you would like to save your recording in.
   If you selected Online Video mode before recording, you will be able to skip conversion by unchecking the *Convert to* box and saving your video in MP4 format.

4. **Convert video**
   Clicking the Convert button will begin processing your recording into the format you have selected.
   If you selected Online Video mode before recording, you will be able to skip conversion by unchecking the *Convert to* box and clicking Save to save your video in MP4 format.

5. **Share video online**
   Click the Share button to add the file to the Share Online module for uploading it to the web once the video has been processed.
Program Preferences

To open the program settings for Movavi Screen Capture, open the Capture menu and select Preferences. You will see the following window:

The preferences are organized into four categories: General, Video, Audio, and Hot Keys. Click the tabs on the left to navigate between them. You can also quickly access audio settings via the Audio > Options menu.
The General tab allows you to change the interface language and set the folder where you want the captured files to be stored by default.

Directory for captured files:
This folder will store both your saved videos and temporary recording files. As you record your screen activity, Movavi Screen Capture stores the recording files in the *.mrec format. These files can be opened at any time using Movavi Screen Capture for saving in a different format. For your convenience, you can change the folder these files are stored in to another location (for example, if you prefer the files to be stored on a different drive), or leave the default Videos\Movavi Library folder.

Acceleration:
Movavi Screen Capture supports the latest hardware and software acceleration methods. If your computer is equipped with an NVIDIA™ graphics card or an Intel® processor, just check the corresponding box to enable the acceleration method. The options will be unavailable if your hardware does not support NVIDIA™ or Intel® acceleration. For more information, please see the Hardware Acceleration section.

Send anonymous usage stats to Movavi:
Selecting this option will allow Movavi Screen Capture to send usage statistics to our development team, enabling us to fix any bugs you may encounter much faster, as well as add new features that you might be missing. The data sent by contains no personal information, will not be disclosed to third parties and will be used for software improvement purposes only. You can find more information about usage statistics on our Movavi Improvement Program page.
The **Video** tab contains the following settings:

![Video Preferences](image)

Here, you can manually specify capture settings for each capture mode. Select a capture mode from the list to edit its parameters.

To change the **capture codec** for the selected mode, click the **Settings** button and select the necessary codec from the list. You can also convert your videos into a more convenient format when saving or using the Convert Video module.

**Maximum capture frame rate**: like in regular video, the frame rate will define how many frames will be captured each second. A lower frame rate will result in smaller output size, however, the video may not turn out as smooth. The recommended frame rate is 20-30 frames per second.

**Output frame size**: defines the dimensions of the captured video. Full size means that it will be captured "as-is", while other frame sizes will result in some scaling to fit the captured area into the specified frame.

![Frame size comparison](image)

For example, if you are capturing a 1280x720 screen with a frame size of 480x320, the captured image will need to be scaled down. Likewise, if the area you are capturing is smaller than the output frame size, the video will need to be scaled up, which results in larger file size with no gain in quality.

Setting custom video preferences allows you to save time if you intend to always capture videos in one format, but some options like a higher frame rate and larger frame size will require more resources. We recommend that you keep the default settings and convert your videos to the necessary format and frame size when **saving**.
Audio Preferences

The Audio tab allows you to change the default recording device and preferred audio quality, including the sample rate, number of channels, and bits per second.
Hot Keys

The Hot Keys tab allows you to set your own custom shortcuts for such actions as starting or pausing the capturing process.

To change one of the shortcuts:
1. Find the command you want to set a hotkey for.
2. (Optional) To set modifier keys (Shift, Ctrl, or Alt), check the corresponding checkboxes.
3. Select an alphanumeric key from the list.

For example, if you check the box next to Alt and select F10 in the Start/Stop capture section, you will be able to start or stop capture using the Alt+F10 combination. In case you forget a shortcut, you can always look it up here in the keyboard shortcut settings.
Preparing to Capture

When you launch Movavi Screen Capture, you will see it appear on your desktop as a small options window and a larger transparent rectangle, like so:

Use the control window to set up your capture area and audio source before recording. Click the links below to find out more about each step:
1. Choose a capture mode
2. Define the capture area
3. Select an audio source
4. Set mouse cursor effects

Once you have everything set up, click the red REC button to begin recording. You will be given a 5-second countdown before the recording starts.
Choose Capture Mode
Movavi Screen Capture has three capture modes: **Screencast**, **Online Video**, and **Game**. The three capture modes are set up to offer you the best capturing experience depending on the type of media you want to capture.

**Capture Screencast**
The Capture Screencast mode uses Movavi Optimized Capture Codec that has high capture quality with an average frame rate. You can use this mode to capture any kind of video from educational videos to technical procedures.

**Capture Online Video**
Use this capture mode for capturing online video from various video hosting sites, sports streams, and IP-TV broadcasts. As online videos are rarely broadcast in HD quality, this mode has average capture quality and speed, which allows to record videos that take up less disc space.

**Capture Game**
The game capture mode captures your games at high frame rates so that your viewers don't miss out on any action. Please be aware that video encoding takes up a part of your computer's resources, so if your computer is not performing as good as usual while capturing games with high hardware requirements, try lowering the game's graphics settings.
Defining the Capture Area

Before you begin capturing, the first thing you will need to do is define which part of your screen you want to appear in the video. You can do this in one of the following ways:

Selecting an area using the smart selection tool:
1. Click the Select button. The screen will dim slightly.
2. Specify a capture area:
   - If you want to capture a window or a window frame, hover your mouse pointer over that frame. Automatically recognized windows will be outlined with a blue border. Click the necessary window once it is highlighted with a border. The capture area will be set automatically to fit the entire window.
   - If you want to draw a custom size capture area, place your mouse pointer where you want the corner of your capture area to be located (it doesn't matter which one), then click and drag the mouse to where you want its opposite corner to be.

Manually selecting a capture area:
1. Define the dimensions of the capture area:
   - Click the drop-down box to open a list of sizes and select one of the Fullscreen, Standard, or Widescreen options that best suits your needs.
   - If you need a capture area size that is not on the list, you can enter its width and height manually into the boxes or click and drag at the red rectangle's borders to change its size.
2. Click the red position icon (>Create<) in the center of the rectangle and drag it to move the capture area into the necessary position.
Selecting an Audio Source

If you want to record audio along with your screen activity:

1. Make sure that the **Audio** option is checked.
2. Select the necessary audio device from the drop-down box. The list will display all your connected devices, including USB-microphones, Built-in Input, as well as any virtual or aggregate devices.

If you want to capture your system's sound, including alerts, music and other sounds you can hear through your speakers, select the **Speakers** or **Stereo Mix** option.

**Troubleshooting:**

If you don't see **Stereo Mix** in the list of recording devices, you will need to enable it on your system:

1. In your system tray, find the volume icon. Right-click the volume icon and choose Recording devices. A sound settings window will open with the list of available recording devices.
2. Right-click on a blank space in the window and make sure both **Show Disabled Devices** and **Show Disconnected Devices** options are checked.
3. You should now see **Stereo Mix** in the list of recording devices. Right-click **Stereo Mix** and select **Enable**. Click **OK** to close the window and restart the Screen Capture module. If after step 2 **Stereo Mix** still does not show up in the list of devices, please update your audio drivers and check that your hardware supports Stereo Mix.

If you need to record microphone or CD input along with sound from your speakers:

1. In your system tray, find the volume icon. Right-click the volume icon and choose **Playback devices**. A sound settings window will open with the list of playback devices.
2. Right-click on **Speakers** and select **Properties**. In the Speaker properties window, switch to the **Levels** tab. You will see a list of sound sources that can be included into Speakers output.

3. Enabled sources are marked with a sound icon 🎧 next to them, while disabled devices are marked as muted: 🖇️. Click the mute icon next to a device to enable it.
4. Click **OK** to save changes and restart the Screen Capture module.
Mouse Cursor Effects
Movavi Screen Capture offers various options for displaying onscreen actions. You can choose to display or hide the mouse cursor as well as draw attention to mouse clicks using a spotlight or sound effect.

To toggle mouse cursor effects:
1. Open the Effects menu
2. Click one of the options to enable it. You can select as many effects as you like. To disable an effect, click on it once again.
Recording Screencasts

1. **Open the Movavi Screen Capture application.**

2. **Choose a capture mode**
   In the upper right-hand corner of the Movavi Screen Capture window, click the screen icon to open a list of capture modes. Each mode is optimized for a certain scenario in terms of quality and frame rate:
   - **Screencast** – ideal for capturing educational videos and tutorials, but it will be just as effective for most video capturing needs. You can leave this mode selected if you're not sure which to choose.
   - **Online Video** – for capturing sports broadcasts, YouTube videos, and any other kind of online video streams.
   - **Game** – a high-speed capture mode for recording games

3. **Set a capture area**
   The red rectangle on your screen represents the part of your screen that will be captured. You can set the size of that area in three ways:
   - Using the mouse, click and drag the corners of the red rectangle,
   - If you need to capture a single program window, click the **Select** button and mouse over the window that you would like to capture. When you see a blue flashing outline around this window, click the left mouse button. The capture area will now be the exact width and height as that window.
   - In the **Capture Area** section of the Movavi Screen Capture window, select a size from the list or enter a custom size into the width and height boxes.

   To move the capture area, click the red position icon in the middle of the capture area and drag it to the necessary part of the screen.

4. **Select audio source**
   If you want to record audio with your screen activity, make sure that the Audio option is checked. Then, select the preferred channel (such as the microphone or line input) and set the audio volume using the slider beneath the Recording source list. If you want to record sounds as you would hear them through your speakers, select the **Stereo Mix** or **Speakers** option.

5. **Set mouse visibility and effects**
   By default, the mouse cursor is hidden when you capture screen activity. However, you can choose to display the cursor or even emphasize its actions using effects.
   Open the **Effects** menu and select **Show cursor** if you want the mouse cursor to be displayed. You can also select an effect to highlight the cursor, its clicks or both.

6. **Start recording**
   Click the rec **REC** button to begin recording. You will see a countdown window before the recording starts so that you will have time to prepare.
While recording, you can click the **Pause** button to temporarily pause capture, and then resume capture from the same place.

When you're done, click the **Stop** button. You will see a player window, where you can preview your video before saving it.

7. **Save your video**
When you are done capturing your video, the next step is to save it for watching in media players.

In the **Convert to** list, select a format you would like to save the recording in. Then, click **Convert** if you want to save the video as a file or click **Share** if you want to upload the video online as well.
Capturing Online Video

For recording sports broadcasts, webinars and any other online video streams, we recommend using the Online Video capture mode that is optimized for better performance when capturing online video content. For example, we will demonstrate how to capture a YouTube video.

1. Launch Movavi Screen Capture.

2. Select Online Video capture mode.
   Click the screen icon in the upper right-hand corner. You will see a list of capture modes. Select **Capture Online Video**.

3. Set up a capture area
   In the **Capture Area** section, click the **Select** button. Move your mouse pointer over one of the corners of the online video, hold down the left mouse button and drag the cursor to the opposite corner. There, release the left mouse button. The rectangle you’ve just drawn over the video will be set as the capture area.

4. Select an audio source
   In the **Recording Source** section, select the audio device that you want to use for sound recording and set the preferred volume with the slider beneath the list. For recording online video, we recommend that you select **Speakers** or **Stereo Mix**.

5. Set up mouse visibility
   Open the **Effects** menu and select how you would like the mouse to appear in the video. Most likely, you will want to hide the mouse cursor when capturing an online video: to do that, select the **Hide Cursor** option and deselect **Use Mouse Click Sound**.

6. Click the red **REC** button to begin recording. The Movavi Screen Capture window will change to recording mode.
   If you've set the capture area to fullscreen, the Movavi Screen Capture panel will hide to your system tray, but you can still use the hot keys to control the recording process.

7. To finish recording and proceed to saving the video, press F10 (or whichever key or combination you have assigned in **hot key preferences**). Movavi Screen Capture will change to conversion mode.

8. Save your video
   To save your recording in the default AVI format, click **Save**.
   If you want to save your video in a different format, select the **Convert to** option and select the necessary format. Click **Convert** to start processing the video.
Your video will be ready in a few minutes.
Capturing Games

1. Launch Movavi Screen Capture.

2. Select game capture mode.
   Click the screen icon in the upper right-hand corner. You will see a list of capture modes. Select **Capture Game**.

3. Select output frame size.
   When you record full-screen games at high resolutions, the output frame size may be too large for some computers, and may require a significant amount of disc space. To increase performance, you can select to record a smaller frame size. In the **Output Frame Size** section, select a suitable size from the list or select **Custom** and specify frame width and height in the boxes beneath the list.

4. Select an audio source
   In the **Recording Source** section, make sure that the **Audio** option is selected and open the list of audio devices to the right. Select the device you want to record sound from during your capture. Select **Stereo Mix** if you want to record game sounds as well as microphone input.

5. Set up mouse effects
   Open the Effects menu and select a mouse effect that best suits the situation. You can use the **Show cursor** option to simply display the mouse on screen without effects or highlights.

6. (Optional) Check your hot key settings
   For an optimally smooth beginning to your video, we recommend that you use hot keys to start and end recording. To check which hot keys are assigned to these actions, open the **Capture** menu and select **Options**. This will open the Options window. There, go to the **Hot Keys** tab and remember which keys correspond to which action or change them to keys or combinations that are comfortable to you. Click **OK** to save the changes and close the Options window.

   The default hot keys are:
   Start/Stop capture – F10
   Pause/Resume capture – F9

7. Launch the game.
   When Movavi Screen Capture is running, you will see a frames per second (FPS) counter in the upper left-hand corner of the game window. You can record games both in windowed and fullscreen mode. You can take your time in preparing the game before you begin recording. For slower computers, we recommend that you lower graphics settings in the game in order to improve performance while capturing.

8. Capture your game
   When you are ready to begin recording, press **F10** or your assigned start capture hot key to start capturing the game. When you're done capturing, press **F10** again to finish recording and proceed to saving and converting your video.

[1] Please note that some computers may have difficulties with capturing high-performance games. If you notice video artifacts or frame skipping in the output video, you can try lowering capture speed in **video preferences**.
Recording Controls

To begin recording screen activity, click the **REC** button in the main Screen Capture window.

You will be given a 5-second countdown before recording begins. Then, the borders of the selected capture area will flash red and the control panel will change to the following:

There are three ways to control the capturing process:

1. **Using the control panel:**
   The **Duration** counter displays the length of your video. Click the **Pause** button to temporarily pause capturing so that you can continue recording into the same file. The Duration timer will pause and the capture area outline will turn white. Click the **Resume** button (located in the same place as the **Pause** button) to continue capturing.

   Press **Stop** if you are done capturing and are ready to save your video.
   Press **Cancel** to terminate recording and delete the temporary files.

2. **Using the tray icon:**

   If you right-click the Movavi Screen Capture tray icon, you will see a context menu appear. Use **Start Recording** and **Stop Recording** to control the recording process.

3. **Using the keyboard shortcuts:**

   Depending on the hot key combinations you have set in the hot key preferences, use those keys to start, stop, or pause capture. The default key for starting and stopping capture is **F10**, and **F9** for pausing and resuming capture.
Saving and Converting Video

When you click the **Stop** button during recording, the control window will change to the following:

You can now use the player to review your video.

The **Delete** button discards the video and permanently deletes the temporary captured file.
The **Share** button opens the Share Online module that you can use to upload the video to the web.
The **Convert** button saves your video in the selected format.

**To convert and save your video:**

1. In the drop-down list, select a format or device preset that best suits your needs. If you don't see the one you need, you can click **More formats** and choose from an extended list, or set up a custom preset.

2. To set up custom conversion settings, click the **Settings** button to the right of the format list. You will see a settings window, where you can set up the video's frame size, audio codec, and more.
3. Click the **Convert** button on the right, or click the **Share** button to upload it to the web after conversion. The program will then begin processing your files.
Saving Previously Captured Files

When you record videos using Movavi Screen Capture, they are first stored as files with the *.mrec extension. These files are located in the directory you've specified in General Preferences, or in the default User\My Videos\Movavi Library folder.

You can later open these captured files in Movavi Screen Capture and save them in the format of your choice. To open the temporary files:

1. In the menu bar, open the Capture menu and select Open Captured File
2. Select the *.mrec file you want and click Open. You can now save or convert the video just like after any other capture.
Sharing Captured Video

1. **Record** or **open** a previously recorded video.
   For detailed instructions on recording and opening videos, see the following sections:
   • Quick Start Guide
   • Saving Previously captured Video

2. Select a format that you would like to save the video in. Most video sharing services accept MP4, AVI, and MOV format videos.

3. Click **Share**. The recording will now be converted to the selected format. After processing is complete, the Share Online program will open with the video added to the list.

4. **Select services for uploading**
   In the bottom panel, click on a service's icon to select it. You can choose to upload to multiple services at once. If you haven't yet authorized with the selected services, the login window will open for each, where you will be asked to provide your credentials. The login data you provide will only be used for authorization with the specified services and never transferred to third parties.

5. In the right-hand column, give your video a title and add a description. For some services, such as YouTube, you will also be asked to select a category and privacy settings for your video.

6. Click the **Upload** button to begin uploading the video.
**Saving Screenshots**

You can use Movavi Screen Capture to save snapshots of any area of your screen, including videos playing in various media players.

1. Set up the capture area to include the part of your screen you want to take a snapshot of. For more information, see the [Defining the Capture Area](#) section.
2. Open the **Capture** menu
3. Select **Take a Snapshot**.
4. You will then be prompted to specify a location and name for the new image. You can save images in BMP, GIF, JPEG, or PNG format.

You can also use a hotkey to take a snapshot. Just press whichever key you have set up as the snapshot key in [Hot Key](#) preferences. If you haven't changed the hot keys, the default snapshot hot key is **F8**.
Troubleshooting

This section describes several frequent issues and the ways to fix them.

I get a black screen when I try to capture video.

Some media players use overlay surfaces for video playback that prevent the video from being captured. Follow the steps to disable overlay surfaces in

For Windows Media Player:
1. In the main player menu, select Tools > Options.
2. Open the Performance tab.
3. Click the Advanced button.
4. Clear the Use overlays checkbox in the Video Acceleration area.
5. Click OK.

For Media Player Classic:
1. Select View > Options from the player main menu.
2. In the lef-hand pane, click Playback > Output.
3. If the Overlay Mixer renderer is selected in the DirectShow Video section, select a different renderer.
4. Click OK.

I minimized the Screen Capture Program and it disappeared. Where I can find it?

The program is minimized to the system tray.

I captured the movie but the file was saved as MREC and can’t be opened with any media player.

MREC format is the special uncompressed format which the video is saved to while capturing. You need to save captured movie after capturing to the one of common video formats. MREC format can be opened with the Screen Capture application (Capture > Open captured file) and Movavi Video Editor.

I try to record online video. I choose Microphone or Line-in in Recorded devices. But I have no sound in the video after capturing. How can I fix it?

You need to choose StereoMix to record the sound from the captured video. If you don’t have this input in the recorded inputs list, you need to turn on the recording using StereoMix input in the Sound settings.
If you use Windows XP please go to Control Panel- Sounds and audio devices properties->Audio-Sound recording – Volume. Then choose Options in the appeared Recording control window and choose Properties->Sound recording. Choose StereoMix (make it active) and click Ok.
If you use Windows Vista please go to Control Panel- Hardware and Sound ->Audio Devices and Sound->Recording. Click with the right mouse button and choose ‘Show disabled devices’ and make StereoMix active.
If you use Windows 7 please go to Control Panel->Sound ->Recording. Click with the right mouse button on the empty field and choose ‘Show disabled devices’ and make StereoMix active.

I captured a video but I can’t find my file. Where can I find it?

To choose the output folder for the resulted file please launch the program and go to ‘Capture->Options’ choose the folder in the field ‘Temporary folder’ and click Ok. Please note that if you don’t save the captured file, it will be recorded as temporary MREC file which won’t be open with any media player.
Contacting Support
If you have any questions or concerns regarding Movavi software, you are welcome to contact our support team. Please describe your problem in as much detail as possible; any screenshots or log files will allow us to help you faster.

The guaranteed response time for e-mails is 3 business days. You can also try our live chat to get a quicker answer.

Our e-mail: support@movavi.com
Phone number: +7 903 902 9831
Phone support is available Monday through Friday, 9 A.M. – 12 P.M.; UTC +7

Have you checked the FAQ section?
It is possible that your question has already been answered!